
Main Index
This index is a list of topics available in the OmniPage Professional Help system.

Accuracy
Basic Skills
Changing Your Installation
Commands
Custom Character Recognition
Error Messages
File Formats
Multiple Zones and Zone Contents
Procedures
Scanners
Troubleshooting

To learn how to use OmniPage Pro's basic features, click on Basic Skills.

For an index of OmniPage Pro procedures for different recognition tasks, click on Procedures.

For an index of all OmniPage Pro commands and settings, click on Commands.

To learn how to use Multiple zones, click on Multiple zones and Zone Contents.

To learn how to train recognition, click on Custom Character Recognition.

For helpful hints on improving text recognition accuracy, click on Accuracy.

For help with troubleshooting installation and operation problems, click on Troubleshooting.

When an index appears, simply click on the topic you need help with and help text will 
appear.



Improving Text-Recognition Accuracy

Document Quality
Scanner Options
Character Window
Scanner Glass Clarity
Paper Transparency

If you use OmniPage Pro to scan a typeset, high-quality printed document, you will probably 
find that the program recognizes text perfectly: the text that appears in the Transitional 
Editor matches the text in the scanned document letter-for-letter.

If conditions are less than perfect, text-recognition accuracy will be lessened.    To help you 
make the most out of the documents you have, this topic explains the factors that most 
affect text-recognition accuracy:



Basic Skills
This topic guides you through the basic steps of using OmniPage Professional to recognize 
text from either a scanned document, image, or fax file.

We assume you have installed OmniPage Professional according to the instructions in 
Chapter 2, Installation, of the Owner's Manual and that you know how to work in the 
Microsoft Windows environment.

Not all OmniPage Professional features are described here; for a complete description of any 
option or setting, see Chapter 4, Commands and Settings, of the Owner's Manual.    Chapter 
3, Procedures, of the Owner's Manual provides outlines of how to use the program for 
various tasks    scanning magazine articles, spreadsheets, graphics, and more.

To use OmniPage Professional, follow four basic steps:

Step 1 Open OmniPage Professional, put a document in your scanner, and click on Scan in 
the Process menu.

Or, if you want to recognize text from an existing image or fax file, click on Open in the File 
menu.

Step 2 Set options in the Scan/Recognize Settings dialog box.

Step 3 Click on OK to process the page and start recognition.

Step 4 Edit and save the file in the Transitional Editor.

For simplicity, OmniPage Professional is referred to in this topic as OmniPage Pro.

Step 1 - Open
Step 2 - Set Options
Step 3 - Process
Step 4 - Edit and Save
For more Information
How to use the Owner's Manual
Online Help



Changing Your Installation
After installing OmniPage Pro, you can change your scanner or delete file format conversion 
filters.

Change a Scanner
Add a File Format Filter



Commands
This topic explains how to use OmniPage Pro commands and settings. It is organized 
hierachically: menu bar title, menu command, dialog box section, setting, and option.

The six OmniPage Pro menus are:

The File Menu lets you manage OmniPage Pro file operations. 

The Edit Menu lets you revise text. 

The Style Menu lets you format text in bold, underline, or italic. 

The Process Menu allows you to configure OmniPage Pro for different kinds of 
tasks. 

The Defaults Menu lets you set up OmniPage Pro to always use some particular 
settings. 

The Help Menu lets you get information about OmniPage Pro and its 
performance. 



The File Menu
From this menu, you can:

Open an existing Caere text file, image or fax file, or deferred job

Save an existing file to disk

Save As a new file to disk

Close (stop working) on a file

Revert to Saved an open file

Print     a file from the Transitional Editor

Exit the OmniPage Pro program



The Edit Menu
From this menu, you can:

Cut text

Copy text

Paste cut or copied text

Clear (delete) selected text and purge the memory buffer

Find/Replace a text string

Check Spelling in a text file

Auto Spell check a text file

This topic also includes information on the Verification Window.



The Process Menu
The Process menu lets you perform OmniPage Pro operations on documents and opened 
image or fax files.    From this menu, you can:

Scan a document

Scan and edit an Image

Quick Scan a document bypassing the Scan Settings dialog box

Train Recognition by creating a character file

Edit Character File to look at and edit the contents of a character file

Create or Edit Zone Contents File



The Defaults Menu
With this menu you can:

Set System options
Choose a Language character set
Setup a Scanner
Set Spelling defaults
Set User Dictionary defaults
Load a file of Default settings
Save a file of Default settings



Custom Character Recognition
This topic explains how to teach OmniPage to recognize special characters that would 
otherwise be unidentifiable. 

Introduction
Custom Character Recognition Examples
How to Create a Character File
Overview of the Procedure
Editing a Character File



File Formats
OmniPage Pro supports the word-processor, spreadsheet, database, fax, and image file 
formats listed in this topic.

Word-Processor, Spreadsheet, and Database File Formats

Fax File Formats

Image File Formats



Multiple Zones and Zone Content
The Multiple zones feature lets you select specific areas of a page for text recognition or for 
saving as a graphic.    The Zone contents feature lets you identify the contents of a zone as 
text and numbers, just numbers, graphics, or a limited set of characters.

Introduction
Multiple Zones Tools
Overview of the Procedure
Edit Zone Contents File



Procedures

This topic describes how to use OmniPage Pro for different kinds of tasks. 
 
To get the most out of this topic, you should have a basic understanding of how OmniPage 
Pro works.    For a tutorial-like introduction to OmniPage Pro, read the Quick Manual.

Procedures outlined here show how to work with:

Simple Documents
Magazine Articles
Spreadsheets
Complex Pages (Zone contents)
Custom Character Recognition (Training)
Automatic Saving
Image/Fax Files
Editing and Saving
Graphics

Each procedure describes, in flowchart style, a type of document or task, appropriate Scan 
Settings, the basic techniques for doing the work, and appropriate tips for getting the most 
out of OmniPage Pro.    The procedures will give you a general idea of how to do the work; 
however, they are not definitive or complete.

See the Commands and Settings topic for detailed explanations and instructions for settings 
described here.    Topics in the Commands and Settings chapter are organized hierarchically: 
left-to-right across the menu bar, and top-to-bottom down the menu commands. 



Troubleshooting
Although OmniPage Pro is designed to allow new users to get up and running quickly, 
problems sometimes occur.    The information in this topic is organized in four sections:

Scanning Problems
You are unable to perform a text or image scan.

Operation Problems
You were able to install OmniPage Pro but certain features do not work, performance is poor, 
or you experience intermittent system crashes.

Using the OmniPage Pro Test Files
You want to verify OmniPage Pro's ability to perform recognition accurately.

Technical Support
You are unable to resolve a problem or you need additional technical information.

Before You Begin Troubleshooting OmniPage Pro

Whatever problem you are experiencing with OmniPage Pro, first verify that your computer 
and other applications are functioning properly.    Windows 3.0 and your scanner's image 
scanning software should be installed and working properly before you install OmniPage Pro. 
If you have a problem with OmniPage Pro, try using other Windows 3.0 applications such as 
Write or Paintbrush.    If the problem occurs when a scanning operation is requested, try 
using the scanning software that came with your scanner.    Resolve any problems that occur 
with Windows 3.0 or your image-scanning software before you try using OmniPage Pro again.



Release Notes
There are no release notes with this Help file.



Scanners
Once a scanner is installed and working with its image scanning software, most users can 
install and use a Caere product with no other changes to their system.

To get up and running as quickly as possible, install your scanner hardware and any software
you received with your scanner according to the manufacturer's instructions. Use the 
scanning software supplied by the manufacturer to be sure the scanner is working on your 
system before scanning with a Caere product. Consult your scanner documentation or your 
scanner's manufacturer if your scanner does not work with the manufacturer-supplied 
scanning software. Resolve any problems before continuing.

The Fujitsu scanners and drivers are only supported under Windows 3.0, not under Windows 
3.1.

Supported Scanners List



Supported Scanners

Scanner Driver Version Interface
ScanMgr

A
Abaton DTP Scan 4 PSCAN.SYS 1.10 EV-2208

SCMGR01.EXE
Abaton Scan 300/FB, 300SF SCN8.COM Revision E ISI-8

SCMGR02.EXE
Abaton Scan 300S, 300GS ABASCAN.SYS 2.01 EV-8114

SCMGR01.EXE
Abaton Transcribe/300 TRANSCRB.SYS 1.0 EV-3114

SCMGR01.EXE
Agfa Focus I, II, and Color None ASC-88

SCMGR12.EXE
Apple OneScanner ASPI2DOS.SYS AHA-1510

SCMGR07.EXE
AVR 3000 AVRTC.SYS 1.05 TIGerCUB

SCMGR08.EXE
B
Brother BS300 USCAN.SYS 4.22 USE-TB Rev B

SCMGR04.EXE
Brother BS300G USCAN.SYS 4.22 GS11-PC

SCMGR04.EXE
C
Canon IX-12, IX-12F IXHND2.COM 1.04 IF-3

SCMGR05.EXE
Canon IX-30F SI3.SYS 1.21 GIX-IF (AZDSI-30)

SCMGR31.EXE
Complete Flatbed Scanner CPCFSCAN.SYS 1.09 Flatbed Scanner Interface

SCMGR08.EXE
Complete Page Scanner CPCSCAN.SYS 2.08 Scanner Interface Board

SCMGR13.EXE
D
DataCopy GS Plus XIS380GS.SYS 1.01 Model 1201 SCSI Adapter

SCMGR07.EXE
DEST PC Scan SCANDRVR.SYS 2.1 DEST PC Interface

SCMGR07.EXE
DEST Scan 2000, Scan 3000 SCANDRVR.SYS 2.1 DEST PC Interface

SCMGR07.EXE
E
Epson ES-300C EPSN300C.PXW NA B808011

SCMGR07.EXE
F
Fora IMG-311, IMG-321, IMG-511 USCAN.SYS 4.22 USE-TB Rev B, GS11-PC

SCMGR04.EXE
Fujitsu 309X w/Dunord interface I2000.EXE 1.03 I-2000

SCMGR55.EXE
Fujitsu 309X w/Kofax interface KF9X00.EXE 1.10 KF-9200

SCMGR07.EXE
Fujitsu 3096G w/Adaptec interface ASPI4DOS.SYS 2.10 AHA-1542



SCMGR07.EXE
G, H
Howtek Personal Color Scanner None Kofax KF-9200

SCMGR07.EXE
HP ScanJet, ScanJet Plus SJDRIVER.SYS 2.0 88290A, 88490A

SCMGR08.EXE
HP ScanJet IIc SJII.SYS 1.39 C1752A

SCMGR42.EXE
HP ScanJet IIp SJII.SYS 1.39 C1752A

SCMGR42.EXE
I
IBM 3119 None

SCMGR07.EXE
J, K
Kyocera A-800 SCNDRV.SYS 1.16 KS-800

SCMGR33.EXE
L
Lightspeed 320F, 300G USCAN.SYS 4.22 USE-TB Rev B, GS11-PC

SCMGR04.EXE
M
Mectel UF32/UF42, UG80 USCAN.SYS 4.22 USE-TB Rev B, GS11-PC

SCMGR04.EXE
Microtek MS-300A MSCAN.SYS 2.5 MS-PCE

SCMGR09.EXE
Microtek MS-300C MSCAN.SYS 2.5 MS-PCX

SCMGR09.EXE
Microtek MS-II MSCAN.SYS 2.64 MS-PCX

SCMGR11.EXE
Microtek MSF-300G, MSF-400G MSCAN.SYS 2.64 MS-PCY

SCMGR09.EXE
Microtek MSF-300Q, MSF-300Z MSCAN.SYS 2.64 MS-PCY

SCMGR09.EXE
Microtek ScanMaker 600G, 600Z MSCAN.SYS 2.64 MS-PCY

SCMGR09.EXE
Microtek ScanMaker 600Z w/ADF MSCAN.SYS 2.64 MS-PCY

SCMGR09a.EXE
N, O, P
Panasonic FX-RS307, FX-RS506 MEISCAN7.COM 4.0 FX-BS181

SCMGR10.EXE
Q, R
Ricoh IS30-M2, RS312 SCN8.COM Revision E ISI-8

SCMGR02.EXE
Ricoh RS320, RS322, RS322+ SCN8.COM Revision E ISI-8

SCMGR02.EXE
Ricoh IS60 (parallel) SCN8.COM Revision E ISI-8

SCMGR02.EXE
Ricoh IS50, IS60 (SCSI) Interface dependent various

SCMGR07.EXE
S
Sharp JX-300 GPIB.DLL GPIB.INI C.12 Nat'l Instr. GPIB-PCII

SCMGR07.EXE



Siig Sirius32, 32GS USCAN.SYS 4.22 USE-TB Rev B, GS11-PC
SCMGR04.EXE

T,U
Umax UF32/UF42, UG80 USCAN.SYS 4.22 USE-TB Rev B, GS11-PC

SCMGR04.EXE
V
Visa FBS300/FBS400,GS300 USCAN.SYS 4.22 USE-TB Rev B, GS11-PC

SCMGR04.EXE
W
Wang SC300 SCN8.COM Revision E ISI-8

SCMGR02.EXE
X, Y, Z



Document Quality
OmniPage Pro recognizes characters in almost any font from 6 to 72 points in size. 
However, keep the following considerations in mind when using OmniPage Pro:

The print should be reasonably clean and crisp. Characters must be distinct: separated from 
each other and not blotched together or run-on.

The document should be free of notes, lines, or doodles; anything that is not a printed 
character will slow OmniPage Pro considerably, and any character distorted by a mark will be
unrecognizable.

The document font must be non-stylized; for example, the Zapf Chancery font is too fancy 
for OmniPage Pro.

It's hard to recognize underlined text accurately; the underline crosses descenders, 
changing their shape.



Scanner Options
Two settings in the Scanner Options section of the Scan Settings dialog box affect text-
recognition accuracy: the Brightness control and Resolution.

Brightness

The Brightness control helps you deal with differences in paper and print quality. By setting 
brightness, you can ensure the highest accuracy of text recognition with all kinds of 
documents: newsprint, glossy paper, thickly inked, etc.

To adjust the Brightness control, either click on the left or right arrows or move the mouse 
pointer to the box, hold the mouse button down, and slide the control left or right. The 
number in the control's box is a reference you can use when you scan other documents. If 
you find that a particular brightness setting is effective with a certain quality of document, 
use that setting the next time you scan.

Auto intensity

OmniPage Pro can automatically set brightness with some scanners. Select Auto intensity if 
you're not sure about the proper brightness setting, if your page is dirty, if text is printed on 
a colored screen, or if the page has shading from a copy machine. Scanning is slower when 
Auto intensity is selected.

Resolution

If your scanner is capable of scanning at 400 dpi, you can set the Resolution list box to that 
setting to improve recognition accuracy. However, recognition speed is lessened at 400 dpi. 
To speed things up, turn off the Verification Window; click on System in the Defaults menu 
and de-select Verification Window in the System Options dialog box. The minimum resolution
for text recognition is 200 dpi.



The Character Window
The Character Window appears while OmniPage Pro performs text recognition on a page; it 
displays small portions of the scanned image. 

The Character Window helps you adjust the correct Brightness setting in the Scanner 
Options. It also shows you if you put the page in the scanner skewed or upside-down. If text 
characters appear thick and run-together, move the slide towards Lighten. If characters 
appear thin and broken, move the slide towards Darken. If characters appear at an angle, 
rescan the document after straightening the page in the scanner.



Scanner Glass Clarity
The sheet of glass on the flatbed of the scanner must be clear. If it gets dirty, wipe it gently 
with a soft, damp, lint-free cloth or tissue. Be sure it is completely dry before you put pages 
on it.



Paper Transparency
Some paper is thin enough that the scanner sees text printed on the opposite side of the 
scanned page. This is often the case with telephone-book pages. To correct this problem, put
a black piece of paper behind the page: between the page and the lid of the scanner.



Error Messages
A scanner error occurred. Aborting...

The scanner is unable to physically complete a scan. Paper jams on a ADF are the most 
common reason for this error.

C:\AUTOEXEC.BAT not found, edit your autoexec.bat manually.

The installation program, OPSETUP, may need to make additions to your autoexec.bat. 
OPSETUP also expects certain operating system options to be already in effect for Windows 
3.0. If you do not have an autoexec.bat file, you must create one. Refer to your DOS 
Operations Manual and your Windows 3.0 User's Guide for information on creating an 
appropriate autoexec.bat file.

Cannot find the Windows swap file.

OmniPage Pro requires a 4MB permanent Windows swap file. You will receive this message if 
you did not create a permanent swap file prior to installing OmniPage Pro or the swap file 
has been removed. Refer to the installation procedures in this manual and your Windows 3.0
User's Guide for information on creating a permanent swap file.

Cannot read file filename.ext.

OPSETUP presents this error message when it cannot read a file on the OmniPage Pro disk 
set. The file is probably corrupted. Contact Technical Support for a replacement disk.

Change to field must be filled in.

 clicked on OK in the Replace dialog box without entering text in the change to field. If you 
open the Replace dialog box and decide not to perform a change, click on cancel. Otherwise,
enter text in the change to field and click on OK.

Error activating Recognition Task.

OmniPage Pro is unable to load and run the recognition portion of the program. This problem
can occur if there is not enough memory to load that portion of the program, if the 
OmniPage Pro files become corrupted, or because of an incompatible memory resident 
device driver or application.

First close any open applications to increase the memory available to OmniPage Pro. If the 
problem persists, reinstall OmniPage Pro using the OPSETUP installation program. 
Finally, examine your autoexec.bat and config.sys files for memory resident applications or 
device drivers that can be removed.

Warning: Do not remove a device driver unless you are aware of its function and know it 
may be safely removed.

Find field must be filled in.

You clicked on OK in the Find dialog box without entering text in the find field. If you open 
the Find or Replace dialog box and decide not to perform a search, click on cancel. 
Otherwise, enter text in the find field and click on OK.



Incorrect filename extension for a dictionary.

The correct filename extension for a user dictionary is .ud. No other filename extension may 
be used for a user dictionary.

Invalid dictionary.

The main dictionary is corrupted. Copy the main dictionary (main dictionaries end with file 
extension .md) from the OmniPage Pro disk set to your OmniPage Pro directory.

Invalid filename.

 The specified filename is incorrect. Check that the entry is correct and typed accurately.

Invalid pathname, filename or directory.

The specified path, filename or directory is incorrect or non-existent. Check that the entry is 
correct and typed accurately.

Main dictionary close error.

See Invalid dictionary.

Main dictionary load error.

There is not enough memory to load the main dictionary or the main dictionary is corrupted. 
Close one or more open applications to free enough memory to open the dictionary. If the 
problem persists, copy the main dictionary (main dictionaries end with file extension .md) 
from the OmniPage Pro disk set to your OmniPage Pro directory.

Main dictionary open error.

See Main dictionary load error.

No text in Find edit cell

You clicked on OK in the Find dialog box without entering text in the find field. If you open 
the Find or Replace dialog box and decide not to perform a search, click on cancel. 
Otherwise, enter text int he find field and click on OK.

Not a line-art image.

OmniPage Pro can only perform recognition on a line-art image. It cannot perform 
recognition on a half-tone (dithered) or grayscale image.

Not enough disk space.

There is not enough disk space to save a text file, temporary file, command file, or character
file on the drive specified. Text files are saved to the drive and directory specified by the 
path you typed in or the default directory in the Save dialog box. Temporary files are stored 
on the drive and directory specified by the DOS SET TEMP command in your autoexec.bat 
file. Command and Character files reside in the OmniPage Pro directory. Check the amount of
disk free disk space in each location and delete any unnecessary files.

Not enough memory to print.



If you have several applications open, you may not have enough memory to print from 
OmniPage Pro. Close one or more open applications to free enough memory to print from 
OmniPage Pro.

Not enough memory to run OmniPage Pro.

OmniPage Pro requires 4MB of available RAM configured as 1MB conventional memory and 
at least 3MB of extended memory. The 3MB of extended memory must be configured for use
with Windows 3.0 running in enhanced mode.

The 4MB Windows permanent swap file (required to launch OmniPage Pro) usually provides 
enough memory to allow OmniPage Pro to run at any time. However, if you have several 
applications open, you may not have enough memory to run OmniPage Pro. Close one or 
more open applications to free enough memory to run OmniPage Pro.

Not enough memory to use the spelling checker.

Close one or more open applications to free enough memory to run the spelling checker.

OmniPage Pro is already running.

OmniPage Pro is already running in background. Only one session of OmniPage Pro may run 
at a time.

Print error.

Your printer may not be properly connected to your computer, or the printer's 
configuration with Windows may be incorrect. Check Printers in the Windows 
Control Panel program.

Scanner read error

OmniPage Pro has found the device driver and interface card and is able to issue commands 
to the scanner. The command issued by OmniPage Pro to the scanner is not completed by 
the scanner.

Several scanners allow you to physically lock down the scanning mechanism so you may 
safely transport your scanner. If the scanning mechanism is locked down, the scanner is 
unable to complete the command issued to it by OmniPage Pro. When a command is not 
completed, OmniPage Pro will wait a few seconds and then issue the "Scanner read error" 
message.

Check the scanner to make sure the scanning mechanism is not locked down or otherwise 
unable to move.

The Complete Page Scanner from the Complete PC will also exhibit this problem if the 
scanning resolution button is set to 200 dpi.

Text is not found.

The search text specified does not exist. Check that the entry is correct and typed 
accurately. There may be punctuation marks or spaces that need to be included in the 
search text.



The temporary directory does not exist.

The temporary directory specified by the DOS SET TEMP does not exist. Check that the entry
is correct and accurately typed in your autoexec.bat file.

There is no more room for text on this page.

You have exceeded the 32K limit for a page in the transitional editor. This may occur if you 
typed or copied and pasted large amounts of text into a scanned page. Save the file and 
continue your editing in your word processor.

Unable to find the key.

This message occurs only with international versions of OmniPage Pro. The hardware key 
that should be on the parallel port is missing.

Unable to initialize scanner.

There are several reasons why OmniPage Pro may not be able to initialize the scanner.
The scanner may be off or the device driver not loaded. The cable connections may be 
loose, the cable connectors have one or more bent pins, or a grounding strap is not 
attached.

Check to make sure the scanner is turned on and the device driver loads when the system 
boots. Power down your computer and scanner to check your cable connections. Remove 
your cables and examine the connectors for bent pins. Reconnect the cables, power up your 
scanner, then power up your computer. Try scanning again with OmniPage Pro.

You may also have a port address or memory address conflict between your scanner 
interface card and another interface card. Run the scanning software provided by the 
scanner manufacturer. If the software exhibits a similar problem, refer to your scanner 
owner's manual to troubleshoot and resolve the problem before continuing with OmniPage 
Pro.

Unable to load the transitional editor

There is probably not enough memory to load the transitional editor. Close one or more open
applications to free enough memory to run OmniPage Pro.

Unable to locate ScanMgr

The ScanMgr file for your selected scanner does not exist in the OmniPage directory. If you 
changed the scanner selection under the Defaults menu, you must copy the appropriate 
ScanMgr file from your OmniPage disk set to your OmniPage directory. See the Scanners 
booklet and the OmniPage installation procedures for additional information.

Unable to open the file. The file is not a Caere (.MET) file.

You tried to open a text file that was not a Caere file (with the extension .met). Caere files 
can only be created by OmniPage Pro.

Unable to read the image file.

The file format for the image file you tried to open is incompatible with OmniPage Pro. This 
may happen with FAX files that have proprietary file formats or TIFF files that use a 



compression scheme or TIFF tags unsupported by OmniPage Pro.

Unable to recognize this page.

Too many errors during recognition is the most common reason for this error. See the section
on Improving Text Recognition earlier in this manual for tips on increasing performance and 
recognition.

Unable to save the text because of a file creation error.

The file cannot be saved because of a creation error at the DOS level. Make sure you have 
not exceeded the number of files for a DOS directory and no other problem exists with the 
disk. Save your file to a different directory or drive until you resolve the problem.

Unable to save the text because of an error opening the file DLL.LST.

The file DLL.LST is corrupted. Copy DLL.LST from the OmniPage Pro disk set to your 
OmniPage Pro directory.

Unable to save the text because there is not enough free disk space.

OmniPage Pro is unable to save the file to the drive requested because there is not enough 
disk space. Save your file to a different drive.

Unable to save the text because there is not enough free memory.

Close one or more open applications to free enough memory to complete the save 
operation.

Unable to start print job.

Your printer may not be properly connected to your computer, or the printer's configuration 
with Windows may be incorrect. Check Printers in the Windows Control Panel program.

Windows in not running in Enhanced Mode. OmniPage Pro cannot run in Standard 
or Real Mode.

OmniPage Pro will only work in Windows 3.0 Enhanced Mode. From the Windows Program 
Manager, choose About Program Manager under the Help menu to find the mode Windows is
using. Refer to your Windows 3.0 documentation for information on running Windows in 
Enhanced mode.

Word is too long for dictionary.

A word must be 50 characters or less to add to a user dictionary.



Changing a Scanner

See the Scanners topic for a list of scanners that work with OmniPage Pro.

To change your scanner installation:

1. Install the scanner according to the manufacturer's instructions.

2. Run the scanning software provided by the manufacturer to be sure the scanner 
works on your system.

(Skip Step 3 if you did not delete unused ScanMgr files after your initial OmniPage Pro
installation.)

3. Decompress and copy the ScnMgr file (and possibly a driver file) for your scanner to 
your OmniPage Pro directory.    To decompress and copy a ScnMgr file:

a. Copy the file Decomp.exe from Disk 1 to your OmniPage directory.

b. Look up the name of your scanner's ScnMgr file in the Scanners boolklet.

c. Insert Disk 3 into your disk drive.

d. Type the following command:

Decomp a:scnmgrxx.ex$ c:\op\scnmgrxx.exe

where xx is the number of your scanner's Scnmgr file, a: represents the disk 
drive with your diskette, and c:\op represents the drive and directory of your 
OmniPage Pro installation.

If you wish to reinstall several or all scnmgr files, reinstall OmniPage Pro.

4. Start OmniPage Pro.

5. Select Scanner in the Defaults menu.

The Select Scanner dialog box will appear.

Your scanner's name should appear in the list box. If the scanner's name does not 
appear, check your OmniPage Pro directory to be sure the ScanMgr file is present.

6. Highlight the name of your scanner and click OK.

Depending on the make of your scanner, a dialog box may appear prompting you for 
information about parameters for your scanner driver. For information about your 
scanner, see the Scanners topic.



Adding File Format Conversion Filters

OmniPage Pro can support the file formats of the programs listed in the File Formats topic. It 
does this by using file format conversion filters. 

OmniPage Pro copies all conversion filters to your hard disk during installation. If you deleted
filters to save disk space, you may need to add a filter to OmniPage Pro. Look up the correct 
conversion file for your program in the File Formats topic, then copy the conversion file to 
your OmniPage Pro directory.

The file format will appear in the OmniPage Pro Format list boxes.



Word-Processor, Spreadsheet, and Database File Formats
OmniPage Pro copies all file format coversion filters to your hard disk during installation. If 
you want to save disk space (about 26K per file), you may delete unused filters. To reinstall a
full set of filters, reinstall OmniPage Pro. 

The chart below lists the applications and their conversion filter file names.

ASCII, ASCII Standard, ASCII Stripped W4W01T.EXE

Ami Professional W4W33T.EXE

Caere (.met) 

DBbase II, III+ W4W70T.EXE

Dec Dx W4W30T.EXE

DisplayWrite (DCA/RFT) W4W15T.EXE

EBCDIC W4W02T.EXE

Enable 1.1, 2.0, 2.15 W4W28T.EXE

Excel Text W4W21T.EXE

Framework III 1.0, 1.1 W4W29T.EXE

GSA NAVY DIF W4W18T.EXE

HP Advance Write Plus W4W22T.EXE

IBM Writing Assist l.0 W4W13T.EXE

Lotus .WK1 W4W20T.EXE

Lotus Manuscript 2.0, 2.1 W4W24T.EXE

Microsoft RTF W4W19T.EXE

Microsoft Word 3.0, 3.1, 4.0, 5.0 ,5.5 W4W05T.EXE

MultiMate 3.3 W4W10T.EXE

MultiMate Adv. 3.6 W4W10T.EXE

MultiMate Adv. II 3.7 W4W10T.EXE

OfficeWriter 4.0, 5.0, 6.0, 6.1 W4W16T.EXE

PeachText 5000, v.2.1 W4W27T.EXE

PFS:First Choice 1.0, 2.0 W4W08T.EXE



PFS:Prof. Write 1.0, 2.0, 2.2 W4W08T.EXE

PFS:WRITE Ver C W4W08T.EXE

Q&A Write 3.0 W4W23T.EXE

Rapid File 1.2 W4W25T.EXE

Samna Word IV, IV+ W4W22T.EXE

Volkswriter Dlx 2.2 W4W11T.EXE

Volkswriter 3, 4 W4W14T.EXE

Wang PC 3.0 W4W26T.EXE

WordPerfect 4.1, 4.2 W4W06T.EXE

WordPerfect 5.0, 5.1 W4W07T.EXE

WordStar 3.3, 3.31, 3.45, 4.0, 5.0, 5.5, 6.0 W4W04T.EXE

XyWrite III, III Plus W4W17T.EXE

The Caere File format has no conversion filter file name and is permanently installed in 
OmniPage Pro.



Fax File Formats
OmniPage Pro supports the proprietary file formats of the fax machines listed below. Other 
fax file formats may work with OmniPage Pro, but these have been tested by Caere. 
OmniPage Pro also supports the .PCX file format; many faxes can receive or convert the .PCX
format.

Brother - Intellifax V1.3
The Complete PC - The Complete Fax
GammaLink - GammaFax
Hayes - JT Fax
Intel - Connection Co-Processor
Panasonic - FX-BM88/89
Quadram - JT Fax 9600 V2.1



Image File Formats
OmniPage Pro supports the following image file formats:

PCX
TIFF Uncompressed
TIFF Compressed 

OmniPage Pro reads Types II, III, IV, and PackBits TIFF files.

OmniPage Pro writes TIFF files in a format compatible with Types II and IV.



Multiple Zones and Zone Contents
The Multiple zones feature lets you select specific areas of a page for text recognition or for 
saving as a graphic. The Zone contents feature lets you identify the contents of a zone as 
text and numbers, just numbers, graphics, or a limited set of characters.

For example, imagine you are scanning a page from a corporation's annual report. The page 
has three distinct elements: text, a table, and a picture of the president.

You want to recognize part of the text (perhaps a quote from the president) and the figures 
in the table. You also want to save the image of the president as a TIFF file. With Multiple 
zones and Zone contents, you can draw a zone around the text you want, draw a zone 
around the table you want and identify the zone contents as Numerics, and draw a zone 
around the picture of the president and identify the contents as Graphics. You can also 
specify the order in which you want the text and table recognized; even though the text is 
before the table on the page, you can have it appear in any order you want in your text file.

By identifying the contents of the table as Numerics, you tell OmniPage Pro to look for 
numbers rather than letters. Without Zone contents, a five (5) might be recognized as an S. 
With Numerics selected, the five will always be recognized as a 5.



Multiple Zones Tools 
After OmniPage Pro scans a page and before recognition, an image of the page will appear 
along with the Multiple zones tools.

The tools lets you select and order zones, zoom the view in or out, and specify zone 
contents: Alphanumerics, Numeric, Graphic, or your own special character set.

See the topics listed below for additional information on the Multiple Zones tools.

Zoom in/out
Draw Zones
Order Zones
Erase Zones
Zone contents



Draw zones

Click on the Draw zones tool and then enclose each area you want recognized (or saved as a
graphic) with a selection box by holding the mouse button down and dragging the mouse. 
Zones will be recognized in the order you select them unless you use the Order zones tool 
(the pound symbol).

A number appears in each zone indicating the order in which the zone will be selected. You 
may draw up to 99 separate zones.

Once you have drawn a zone, you can adjust its size. First, click on the zone to select it. 
Handles will appear on the edge of the selection box. Then move the mouse pointer to a 
selection box border, hold the mouse button down, and move the mouse to adjust the box 
size.



Erase zones
If you want to de-select a zone, click on the Erase zones tool and then click on the zone you 
want to de-select. The contents of the zone will not be affected; only the selection box will 
be removed.



Zoom in/out
If you want a close-up view of an area, click on the Zoom in tool and then click on the area of
the page you want enlarged. Click on the Zoom out tool and then click on the area to return 
to a normal view.

The levels of zoom are Fit in Window, 25%, 50%, and 100%. The 100% view gives you a 
pixel-for-pixel view of the scanned image. If you want to zoom all the way in or out, hold 
down the CTRL key when you click on a zone with a zoom tool.



Order zones
Normally, zones are recognized in the order you select them. To change the order in which 
the zones will be recognized, click on the Order zones tool.    The numbers in the zones will 
disappear.

Click on the zone you want recognized first. The number 1 will appear in the zone. Then click
on the next zone you want recognized; the number 2 will appear. Continue until the zones 
are appropriately ordered.



Zone contents
You can identify the contents of a zone as Alphanumerics (letters and numbers), Numerics 
(numbers), Graphics, or your own special character set.

To identify zone contents, select the zone by clicking on the zone while the Draw zones tool 
is selected. 

The current zone contents status will appear in the Zone contents list box. To change the 
zone contents, click on the appropriate listing in the Zone contents list box.

In the example we gave for the annual report, you would identify the contents of the text as 
Alphanumerics, the contents of the table as Numerics, and the contents of the picture as 
Graphics.

If you specify Graphics, the Save Graphic Zones As dialog box will appear when you click 
Recognize in the toolbar. You can enter a file name of up to four characters only. OmniPage 
Pro automatically appends three numbers and a letter to the file name and increments these
characters if you selected multiple graphic zones. The first graphic zone file name will have 
the characters 001A appended to it. The 001 indicates the page the graphic is on. If you are 
scanning multiple pages and the first graphic zone was on page three, the number would be 
003. The A indicates the number of the graphic zone on the page. If you selected three 
graphic zones on the first page, the first number would be 001A, the second number would 
be 001B, and the third number would be 001C.

You can create a zone contents file that just contains characters you select. For example, 
you may want to recognize a spreadsheet that contains numbers, dollar and percentage 
symbols, and the letters CR and BAL.    By selecting Edit Zone Contents File in the Process 
menu, you can create a special zone contents file just for your special case.

Multiple pages and Interactive mode
If you selected Multiple pages in Page Options (and you did not select Interactive mode in 
Recognition Options), the same zones will be recognized on each page that is scanned. For 
example, if you select a zone on a form, and then scan five forms, the same zone will be 
recognized on each form. 

If you selected Interactive mode, the Scan Settings dialog box will appear after each page is 
scanned and you can select different zones.

If you would prefer that previously selected zones reappear whenever Multiple zones is 
selected, de-select Multiple zones - clear after each scan in the System Options dialog box. If
you would prefer that the Scan Settings dialog box not appear with each page when 
Interactive mode is selected, de-select Interactive mode - set Scan Settings in the same box.
The System Options dialog box is available by clicking System in the Defaults menu.



Overview of the Procedure
1. Select Scan Settings, including Multiple zones, and click OK.

2. Image of page and the Multiple zonestools appear: draw zones.

3. Use tools to zoom, order, erase, and specify zone contents.

4. Click Recognize in the toolbar.

5. If necessary, specify a four-character file name in the Save Graphic Zones As... dialog
box.



Edit Zone Contents File
Select Edit Zone Contents File in the Process menu to create or edit a special file of 
characters for use with the Zone contents feature.

Your spreadsheet may contain characters that are not included in the Numerics zone 
contents file.    For example, you may use BAL to indicate balance or CR to indicate credit. 
You can add the BALCR characters to the Numerics file or you can create a new file with just 
the characters you need.

To create or edit a zone contents file:

1. Select Edit Zone Contents File in the Process menu.

The dialog box lists all current zone contents files on your system.

2. If you want to edit an existing file, highlight the file name in the list box and click on 
Edit.

If you want to create a new file, click on New.

The dialog box contains a list box of the extended ANSI character set and an edit box 
of characters in the zone contents file. If you selected New, the 94 character (typical 
keyboard) ASCII character set is displayed.

3. Edit the contents of the edit box by typing in characters you want to add to the file 
and deleting (with your Backspace or Delete keys) undesired characters. If you want 
to add a character from the extended ANSI character set, double click on the 
character in the ANSI character list box; the ANSI character will appear in the edit 
box.

4. Select Reset to replace the contents of the edit box with the ASCII character set.

Select Save to save your changes to an existing zone contents file.

Select Cancel to return to the first Edit Zone Contents File dialog box without saving 
any changes.

All zone contents files appear in the Zone contents list box in the Multiple zones tools.



Step 1 Open
To open the program, double-click on the OmniPage Professional icon in the Windows 
environment. Unless you have changed your Windows setup, the icon should be in the Caere
Applications program group box. 

OmniPage Pro will recognize images from two sources: your scanner or a disk. If you want to 
scan a document and recognize text:

1. Load the document in your scanner.
2. Click on Scan in the Process menu.

If you want to recognize text from an existing image or fax file:

1. Click on Open in the File menu.
 The Open dialog box will appear

2. Click on the Image/Fax button located in the middle of the dialog box.

 Any image or fax files in the current directory will appear in the left-hand list box.

3. Click on the file you want recognized; it will appear in the right-hand list box.

4. Click on the Recognize button.



Step 2 Set Options

Page Options
Recognition Options
Scanner Options
Save Options

After you click on Scan in the Process menu or Recognize in the Open dialog box, the 
Scan/Recognize Settings dialog box will appear.

In this dialog box, select options that describe the page you are scanning, how you want 
OmniPage Pro to recognize text, scanner parameters, and save procedures.



Page Options
Select Page Options that describe the physical characteristics of the page you are scanning.

The basic settings are for size and orientation:

Size - Select a paper size: either Letter, A4, or Legal. 

Orientation - Select how text on your page is arranged: either Portrait or Landscape. 
Landscape indicates that the page is printed lengthwise like a spreadsheet.

Other options let you select for dot-matrix print or OCR-A font, multiple pages, or image only
(when you want to scan an image for use as a graphic).

If you are recognizing an image or fax file, only the Doc type option is available.



Recognition Options
Select Recognition Options that describe how you want OmniPage Pro to recognize columns, 
whether you only want certain areas of the page recognized, and so on.

The basic settings are for Column selection mode and Multiple zones:

Column selection mode - Select Auto detect in the list box to let OmniPage Pro automatically
determine the number of columns in your document. 
Select Single column/Tables in the list box if you are scanning a table or spreadsheet; 
although a table has many small columns, it must be recognized with this setting. 
Otherwise, the data will be improperly formatted.

Multiple zones - Select this option if you only want certain areas of a document recognized. 
For example, you may only want a few paragraphs recognized out of an entire page. You will 
select recognition zones before the document is recognized.

Other options let you use a character file to aid recognition, retain a document's original 
format, and more.



Scanner Options
Select Scanner Options to set parameters for your particular scanner.

For recognizing text files, only the Brightness and Resolution options are available:

Brightness - Adjust this control toward Lighten or Darken depending on the print quality of 
your document. If text characters are thick and run-together, move the slide towards 
Lighten. If characters are thin and broken, move the slide towards Darken.
Use the number in the slide control as a reference when you scan other documents.

Resolution - If you have a 400 dpi scanner, you can select 400 dpi in the Resolution list box. 
However, recognition is much faster when you select 300 dpi.



Save Options
Save Options let you set different ways of saving files: automatically, with incremented file 
names, etc. For a detailed description of these special features, see the Process 
Menu/Scan/Save Options section of Chapter 4, Commands and Settings, in the Owner's 
Manual.



Step 3 Process
Click on OK at the bottom of the Scan/Recognize Settings dialog box after you have set 
options. 

Multiple zones
If you selected Multiple zones in the Scan Settings Recognition Options, an image of the 
document and a toolbar and toolswill appear on the screen. The tools lets you select and de-
select zones, order zones for recognition, and zoom in or out.

1. Click on the Draw zones tool (the selection box) and then enclose each area you want 
recognized with a selection box by holding the mouse button down and dragging the 
mouse. Zones will be recognized in the order you select them unless you use the Order 
zones tool (the # symbol).

A number appears in each zone indicating the order in which the zone will be recognized.

You may draw up to 99 separate zones. If you want to de-select a zone, click on the 
Erase zones tool (the eraser) and then click on the zone you want to de-select. (Only the 
selection box will be erased - not the zone itself.)

To adjust a zone, first select it by clicking on the Draw zones tool and then clicking on the
zone. Then move the mouse pointer to a selection box handle, hold the mouse button 
down, and move the mouse.

To learn how to use the other tools, refer to the Multiple Zones and Zone Contents topic.

2. Click on OK in the toolbar to start recognition.

Recognition and the Recognition Window
Before OmniPage Pro recognizes text, it parses (divides) the page (or selected zones) into 
text blocks and graphics. Graphic areas are separated out and text blocks are outlined.

During recognition, text blocks are painted gray and then black on the screen as OmniPage 
Pro works. Meanwhile, the Recognition Window appears; it displays small samples of the 
scanned image.

The Recognition Window helps you adjust the correct Brightness setting in the Scanner 
Options. It also shows you if you put the page in the scanner skewed or upside-down. If text 
characters appear thick and run-together, move the slide towards Lighten. If characters 
appear thin and broken, move the slide towards Darken. If characters appear at an angle, 
rescan the document after straightening the page in the scanner.



Step 4 Edit and Save
After recognition, the text automatically appears in the Transitional Editor.

The Transitional Editor lets you check recognition quality and edit the file before you save it 
in your word-processor, database, or spreadsheet format. 

Edit
The Edit menu has standard Cut, Copy, and Paste features. Find..., Find Same, Replace..., 
and Replace Same help you search and replace text strings.

The spelling features let you edit your document with a full-featured, interactive spelling 
checker. See the Commands and Settings topic for a complete description of all the spelling 
features.

The Verification Window
The Verification Window is an important feature that lets you check the context of text you 
want to edit. If you double-click on a word in the Transitional Editor, the actual scanned 
image of the word and its surrounding area will appear. You can then edit the text file 
accordingly.

Save
After editing, click on Save As in the File menu to save your work. The Save As dialog box will
appear.

You can save your file in any of the word-processor or database formats listed in the Text 
Save Options/Format list box. If you are not sure what format to choose, select the Caere 
(.met) format. You can re-open Caere-format files in OmniPage Pro and then save them in 
any of the listed formats.



For More Information... 
The instructions in this help file only scratch the surface of OmniPage Pro's capabilities. To 
learn more about OmniPage Pro features, please read the Owner's Manual. 



How to Use the Owner's Manual 
The Owner's Manual has complete, definitive instructions on how to use all of the program's 
features. 

To get an idea of things you can do with OmniPage Pro, read Chapter 3, Procedures. 

For complete descriptions of OmniPage Pro features organized in a hierarchical structure, 
read Chapter 4, Commands and Settings. 

To learn more about two very useful Recognition Options, read Chapter 5, Multiple Zones and
Zone Contents. 

For a tutorial-like guide to OmniPage Pro's training capabilities, read Chapter 6, Custom 
Character Recognition. 

For tips on how to get the most accurate recognition from OmniPage Pro, read Chapter 7, 
Improving Text-recognition Accuracy.



On-line Help
On-line Help is available within the OmniPage Pro program by selecting Help Index in the 
Help menu. The Help program follows the standard Windows Help format; the Help Index is a
list of topics such as Basic Skills, Procedures, and Commands and Settings. 



Custom Character Recognition
OmniPage Pro automatically recognizes a limited ANSI character set: the characters most 
often used in most documents. But what if your document contains special mathematical 
symbols, or you are recognizing text in a chess book where symbols are used to denote 
Kings, Queens, and other chess pieces?

Custom Character Recognition lets you teach OmniPage Pro to recognize these special 
characters that otherwise would be unidentifiable. You create a Character file that OmniPage
Pro can use to augment text recognition. This file is a set of your pre-identified symbols or 
characters.

After you create a Character file, it is listed in the Character file list box. This list box is in the
Recognition Options section of the Scan Settings dialog box.

You can create as many character files as you like; they will all be available in the list box. If 
you don't need to use a character file, you can select None in the list box. Recognition is 
faster when None is selected.

When OmniPage Pro recognizes a document, it first tries to identify all the characters using 
feature analysis: it looks at the shape of a character and identifies it as a text character in 
the limited ANSI character set. If you selected a character file to augment recognition, 
OmniPage Pro then compares any characters or symbols it can't identify with the pre-
identified ones in your character file. If it finds a match, it identifies the character or symbol 
as you identified it in the character file.



Custom Character Recognition Examples
You will be scanning mathematics documents that contain the Greek letter beta. You create 
a character file that contains beta. When OmniPage first tries to recognize the text, it will not
recognize beta as a letter. It then compares the shape to the characters in the character file.
Finding a match, it correctly recognizes the character as a beta in your text file.

You have a set of pages printed in an unusual font. OmniPage Pro does a near-perfect job of 
recognizing the characters; however, the number five (5) in this font looks a lot like the 
letter ess (S), and it is sometimes mis-recognized in your text file. To solve the problem, you 
create a character file that identifies the number five as, indeed, a 5. When OmniPage Pro 
uses the character file, recognition is perfect.

You are recognizing text from a chess book. Unfortunately, instead of printing the words King
or Queen, the book prints the symbols for these pieces. You create a character file that 
identifies the different chess symbols as the text strings King, Queen, and so on. In your text
file, instead of getting something like Your ~ can now check the ~, you'll get Your Queen can
now check the King.



How to Create a Character File
Creating a character file is a matter of three steps:

Scan a sample page
Specify unrecognized characters
Save the set of identifications as a character file



Scan
The first step in creating a Character file is to scan a sample page.

1. Put a sample page in the scanner that includes the characters you want represented 
in the character file.

This feature only works with fully formed characters. Dot-matrix printed characters 
cannot be trained.

2. Select Train Recognition in the Process menu.

The Train Settings dialog box will appear.

3. Select the appropriate settings that describe your sample page.

The Train Settings dialog box is a subset of the Scan Settings dialog box. The settings 
are thoroughly described in the Process Menu/Scan entry in Chapter 4, Commands 
and Settings.

An exception is the Partial page setting. If this is selected, the Multiple zones screen 
will appear after the sample is scanned; however, you may draw only one zone.

4. Click on OK.

OmniPage will scan and recognize text in the sample page.

You can click on Open File in the Train Settings dialog box to load a TIFF or PCX file for 
recognition.



Specify
After recognition, the Train Recognition dialog box will appear.

This box displays unrecognized and recognized characters from the sample page. Each box 
shows the character and, if it was recognized (wrongly) as a character, what OmniPage Pro 
thought the character was. 

To specify a character:

1. Double-click on an unrecognized or mistakenly recognized character or click on the 
Specify button to specify it.

The Specify Character dialog box will appear.

This box displays a close-up of the character, a list box of ANSI characters, and an 
edit box.

2. Select the correct character in the ANSI list box or type it in the edit box.

If the character you want to specify belongs to the extended ANSI character set, 
double-click on the character in the ANSI list box on the left. If you are specifying a 
character that is represented on your keyboard, type the character in the edit box.

If the character does not belong to the ANSI character set, you can enter a particular 
character or character combination in the edit box. For example, you can type in 
/sigma/ for the character. When OmniPage Pro creates a text file, it will substitute 
/sigma/ for that character. Then, when you use a text-handling program that can 
produce non-ANSI characters, you can search and replace /sigma/ with the 
appropriate Greek-letter character.

3. Click on OK.

The Train Recognition dialog box will reappear; you can specify as many characters as
you like by repeating the above steps.



Save
 After you have specified your characters, save your file or append your specified characters 
to an existing character file.

1. Click on OK or Append in the Train Recognition dialog box to save or append specified
characters to a character file.

Only characters that you identified in the Specify Character dialog box will be saved 
or appended. All others will be ignored.

The Save Character File dialog box will appear.

2. Enter or highlight a filename and click OK. 

The Scan Settings dialog box lists all character files.



Overview of the Procedure
The following instructions reiterate the sequence for creating a character file:

1. Put a sample page in the scanner.

2. Click on Train Recognition in the Process menu.

3. Adjust settings and click OK in the Train Settings dialog box.

4. Highlight the character to specify in the Train Recognition dialog box. Click on the 
Specify button. 

5. Specify character in the Specify Character dialog box.

6. Repeat above two steps as necessary.

7. Click OK in Train Recognition dialog box.

8. Name the character file and click OK in the Save Character File dialog box.



Editing a Character File
Select Edit Character File in the Process menu to edit or view an existing character file.

You may, at some point, want to add to your character file; or, you may not be sure what 
characters are in a particular file and you may want to look at it. 

To edit a character file:

1. Select Edit Character File in the Process menu.
The Load Trained Characters dialog box will appear.

2. Select the name of the character file you want to view or edit and click OK.
The Train Recognition dialog box will appear.

3. Use the feature just as it is described in the "How to Create a Character File" starting 
with Specify.

You can make changes and save the file or simply look at the file and not save it. If 
you save the file, all the characters in the Specify Character dialog box will be saved.



Scanning Problems
If you think the problem you are experiencing is scanner related, you can test OmniPage 
Pro's ability to perform recognition and other functions by opening a TIFF file for recognition. 
The file OPTEST.TIF and its corresponding Settings file, OPTEST.CMD, is provided on the 
OmniPage Pro disk set and was copied to your OmniPage Pro directory during the installation
of OmniPage Pro. You will find the procedure for using these files in the topic, Using the 
OmniPage Pro Test Files.

If OmniPage Pro successfully completes recognition, the problem is probably scanner related.
Continue reading the information in the Scanner subtopics listed below and review the 
scanner error messages in the Error Messages topic.

If OmniPage Pro is unable to perform recognition, review the installation and operation 
troubleshooting sections and the corresponding error messages in the Error Messages topic.

Scanner Hardware
Scanner Software



Scanner Hardware

OmniPage Pro supports most of the scanner hardware configurations shipped by a scanner 
manufacturer.

However, if you are experiencing a problem between OmniPage Pro and your scanner, verify 
that the hardware used matches the hardware OmniPage Pro supports. For example, 
OmniPage Pro supports a Canon IX-12 scanner, but only with the Canon IF-3 interface card, 
not the older IF-2 or the JLaser interface card for Canon scanners.
The Scanners booklet explains the scanner hardware configurations expected by OmniPage 
Pro.

For many scanners you will also need to know the scanner interface card switch settings and
addresses. Refer to your scanner owner's manual for information on the scanner interface 
card switch settings and address options.



Scanner Software

There are two or more files that make up the software interface that allows OmniPage Pro to 
communicate with the scanner hardware. One is called a device driver, which is often 
supplied by the scanner manufacturer and may be used by more than one scanning 
application. The other is a program called ScanMgr, which is only supplied with and used by 
OmniPage Pro.

Device Drivers

When you turn your system on, DOS will load any device drivers it finds in your config.sys or 
autoexec.bat file. Check the information about your scanner in the Scanners booklet to find 
the device driver name, version, and whether an entry needs to be made in the config.sys or
the autoexec.bat file.

Compare this information with the contents of your config.sys or autoexec.bat file. 
Sometimes the installation procedure for scanning software provided by the scanner 
manufacturer will not install the device driver OmniPage Pro needs or will install a different 
device driver.

If the device driver name and version in your config.sys or autoexec.bat file does not match 
the information listed for your scanner, check the Scanners booklet to see if the correct 
driver is supplied with your OmniPage Pro disk set, and copy the driver to the OmniPage Pro 
directory.

If the correct device driver is not supplied on your OmniPage Pro disk set (which will happen 
if Caere does not have license to distribute the driver), contact the scanner manufacturer 
and request the driver specified in the Scanners booklet for your scanner.
Edit your config.sys or autoexec.bat file to allow DOS to load the device driver required by 
OmniPage Pro. For information on how to edit your config.sys or autoexec.bat file, see your 
DOS Operations Manual. Be sure to reboot your computer when you have finished editing. 
DOS will load the new device driver when the system reboots.

Here are a few examples of device driver entries in a config.sys or autoexec.bat file.

A typical config.sys entry for a Microtek scanner device driver would look like this:

 device=c:\pro\mscan.sys

This line in your config.sys file tells DOS to load the device driver named mscan.sys, which is
located in the PRO directory on the C drive.

Some device drivers require one or more parameters designating port address, interrupt 
(IRQ), or Direct Memory Access (DMA) channel. The values for the parameters are 
determined by the switch settings and addresses used in the scanner hardware installation. 
See your scanner manual for information on these settings.

An entry in your config.sys for the Complete Page Scanner might look like this:

 device=c:\pro\cpcscan.sys 2e0 2 1

Other device drivers are loaded with a batch file, usually the autoexec.bat file, instead of the
config.sys.

An entry in your autoexec.bat for the Canon IX-12 scanner could look like this:



 c:\pro\ixhnd2/08

This line in your autoexec.bat file tells DOS to load the device driver called IXHND2 and 
defines the port address and memory address for the device driver to use when 
communicating with the scanner interface card.

Record any parameter information. For a few scanners, this information will be required 
when you launch OmniPage Pro for the first time or if you change your scanner installation. 
Refer to the Scanners booklet to find what parameter information you will need for your 
scanner software installation. 

Warning: Load only one device driver for your scanner at a time. Multiple device drivers for 
the same scanner may cause problems between OmniPage Pro and the scanner hardware.

ScanMgr

There is a different ScanMgr file for each scanner or scanner family supported by OmniPage 
Pro. The device driver entry in your config.sys or autoexec.bat must be the device driver the 
ScanMgr file expects or an error will occur. Select Scanner from the Defaults menu if you are 
unsure which ScanMgr file is installed. The scanner selected in the Select Scanner dialog box
indicates the ScanMgr file in use.



Operation Problems
OmniPage Pro works but operates slowly and frequently accesses the hard disk 
drive.

As a Windows 3.0 application, OmniPage Pro is able to take advantage of the Windows swap 
file when running low on memory. This may occur with a minimally configured system (only 
4MB of RAM), if memory has become fragmented with use or if other applications are 
running in background. When low memory conditions occur, Windows will use disk space to 
simulate the RAM it does not have available. Disk access time is much longer than RAM 
access time; the computer system will run much slower when it has to use a swap file. 

A quick fix for memory fragmentation problems is to quit OmniPage Pro and Windows and 
reboot your system. This will clear any fragmentation of memory that has occurred (until, of 
course, it happens again).

Try closing any other applications that are running in background. This will usually free 
enough memory for OmniPage Pro to operate without using the swap file.

If you regularly work with long, complex documents, adding more RAM to your system would
be the best solution.

For more information on optimizing your system and application performance under 
Windows 3.0, refer to the Windows User's Guide.

The scanner moves slowly when used with OmniPage Pro but operates normally 
when used with another scanning application.

OmniPage Pro scans slowly when the Verification Window is used. Turn off the Verification 
Window by selecting System from the Defaults menu to increase scanning speed when 
verification is unnecessary (as with high-quality documents that produce few recognition 
errors).

The scanner will begin to scan and stop. The entire system locks up and you have 
to reboot your computer.

You may have an interrupt conflict between your scanner and another device. If you have a 
bus mouse and you usually do not use the mouse and scanner at the same time, check the 
interrupt used by the scanner and mouse for a possible conflict. The interrupt address 
typically used by some network cards may cause the same problem.



Using the OmniPage Pro Test Files
Use the OmniPage Pro test files to verify the functionality, recognition performance, and 
accuracy of OmniPage Pro. Successful completion of the test procedure:

verifies OmniPage Pro's ability to perform text recognition

provides a benchmark for recognition time on your system

verifies recognition accuracy independently of your document or scanner image quality.

If you are experiencing a problem with OmniPage Pro but are able to successfully complete 
recognition with the test file, the problem is probably scanner related.

If OmniPage seems to run slowly even with all other applications closed, use the test files 
and procedure to find the typical recognition time for a good-quality document and image on
your system.

The test files will produce a text file with 100% text recognition accuracy. If you are unable 
to achieve a similar level of accuracy with your documents, review Chapter 7, Improving 
Text-Recognition Accuracy, for possible problem areas and solutions.

To load the test command file and TIFF file:

1. Select Load in the Defaults menu.
This will open the Load Settings dialog box.

2. Double-click on the file optest to select the test command file.
You will receive the message:

Settings from: optest have now been loaded

3. Click on OK.

4. Select Open in the File menu.

5. Locate and select your OmniPage Pro directory in the Directories list box. 
Make sure the Image/Fax button is selected.

6. Click on optest.tif to select the test TIFF file.

7. Click on Recognize.
The Recognition Settings dialog box will appear.
Warning: Do not change any of the settings!

8. Click on OK .
OmniPage Pro should now load the test TIFF file and perform recognition.



Technical Support
If you need further assistance, contact Caere Technical Support at 1-800-GO-CAERE (1-800-
462-2373). To get help as quickly and efficiently as possible, please be near your computer 
and have the following information ready when you call:

OmniPage Pro Serial Number

OmniPage Pro Version

DOS Operating System version

Scanner Manufacturer and Model

The amount of RAM in your system

The amount of free conventional memory available

A listing of the autoexec.bat file

A listing of the config.sys file.

The size and location of your Windows swap file

The make and model of your computer system and peripheral devices (printers, 
monitors, etc.)



Simple Documents
The procedure for recognizing text from simple documents is the basic method for 
performing most OmniPage Pro operations: you adjust Scan Settings, click OK to start the 
scan, edit the resulting text file in the Transitional Editor, and save the file in an appropriate 
format.

Simple documents, such as letters or legal briefs, have regular columnar structure (either 
one column or multiple, evenly spaced columns).    We'll assume that you want all the text on
the page recognized.    Any graphics on the page will be ignored.

1. Load a document in your scanner.

2. Select Process Menu/Scan.

3. Adjust Scan Settings.
Set Page Options: Size. (legal?)
Set Recognition Options: Column selection mode/Auto detect.
Set Scanner Options: Brightness.

4. Click OK.

OmniPage Pro will scan and recognize the page.    After recognition, the resulting text file will 
appear in the Transitional Editor for editing and saving.

Legal briefs have line numbers printed on the left margin.    If you want to keep text 
formatted like the original document with the line numbers intact, save the file in ASCII 
format; a carriage return will be added to the end of each line.    If you don't want the 
numbers recognized, select Multiple zones in Recognition Options and draw a zone around 
just the text you want recognized.

With legal briefs, remember to adjust the Page Options Size setting to Legal. 



Magazine Articles
Magazine articles are typically spread out over several pages and have multiple columns.    
Graphics, ads, and insets usually break up each page differently.    With this procedure, you 
can draw zones on each page around just the text that belongs to the article and then 
recognize all the zones at once.

1. Adjust Scan Settings.
Set Page Options: Multiple pages.
Set Recognition Options: Column selection mode/Auto detect, Multiple zones, Defer 

recognition,    Interactive mode.
Set Scanner Options: Brightness (Darken for glossy paper).

2. After the scan, use the Multiple zones tools and draw zones around the desired text.    

3. Click Recognize in the toolbar.

4. Repeat the above step for each page.

5. Respond to the prompt: either perform recognition immediately or save the scan as a
deferred job for later recognition.

A deferred job can be recognized at any time from the File Menu/Open dialog box.    Deferred 
jobs have a .job extension.

Even though text may be formatted in several columns in the magazine, it will be in one-
column format when the text appears in the Transitional Editor.    To re-create columnar 
structure, set the Columns command in your word processor or publishing software.    You 
may wish to create a columnar style sheet or template in your word processor for easy 
reformatting.

If you are recognizing zones on several pages with Interactive mode selected, you can set 
system defaults so that the Scan Settings dialog box does not reappear after each page is 
scanned.    Select System in the Defaults menu and de-select Interactive mode - set Scan 
Settings.

If you are recognizing the same areas on each page, you can set system defaults so that the
same zones will reappear on each page. Select System in the Defaults menu and de-select 
Multiple zones - clear after each scan.



Spreadsheets
OmniPage Pro identifies spreadsheets and tables by the regular distances between fields.    
As long as there are five or more en spaces between a field, OmniPage Pro will convert the 
spaces into a TAB space.    Most spreadsheet applications recognize the TAB space as a 
delimiter for a new field.

A feature of OmniPage Pro is the ability to identify the contents of a zone.    By using the 
Multiple zones tools to identify a zone as containing all numerics, numbers printed in 
spreadsheets and tables will be recognized much more accurately.

1. Adjust Scan Settings.
Set Page Options: Size (legal?),Orientation (landscape?), Doc type (dot matrix?).
Set Recognition Options: Column selection mode/Single column/Tables, Multiple 

zones.
Set Scanner Options: Brightness (Darken if dot matrix).

2. After the scan, use the Multiple zones tools and draw a zone around the desired area. 
Identify Zone contents as Numerics.

3. Click Recognize in the toolbar.

4. Save the file in a spreadsheet, database, or word-processor format.

If spreadsheet data looks jumbled in your word processor, try adjusting the word processor's 
TAB settings.    Also, tables are often printed in a smaller point size than surrounding text; as 
a result, lines of table data may wrap around in your word processor.    To properly format the
data, you may have to reduce the data's point size.

If your spreadsheet uses letters such as CR or BAL, you can add them to the Numerics zone 
contents file.    Select Edit Zone Contents File in the Process menu.



Complex Pages    (Zone contents)
Some pages have several different components.    For example, a corporation's annual report
may have text, an officer's picture, and a table on the same page.    With OmniPage Pro, you 
can save the officer's image, recognize partial areas of text, and recognize the table as 
numerics only - all with one scan.

1. Adjust Scan Settings.
Set Page Options. 
Set Recognition Options: Column selection mode/Auto detect, Multiple zones.
Set Scanner Options: Brightness.

2. After the scan, use the Multiple zones tools and draw a zone around the desired 
graphic.    Identify Zone contents as Graphics.

3. Draw a zone around the table.      Identify Zone contents as Numerics.

4. Draw a zone around the desired text.          Identify Zone contents as Alphanumerics.

5. Click Recognize in the toolbar.

For highest-quality graphic reproduction, select Image only in Page Options and scan the 
entire page to create an image file.    This will let you set different Scanner Options such as 
Tone and Contrast.    You can then crop the portion of the page image you need with your 
graphics application.    

If you also want to recognize text on the page, scan the page again: turn off Image only, 
adjust other settings, and rescan.



Custom Character Recognition (Training)
Technical documents may contain characters such as Greek letters (beta, mu) that 
OmniPage Pro normally does not identify.    Specialized fonts may contain characters that are 
consistently mis-recognized; a document with particularly tight kerning may have 
unrecognizable letter pairs; or, a broken printer may consistently misprint a particular 
character.

The OmniPage Pro Custom Character Recognition feature lets you scan a sample page, 
identify special characters, and create a character file.    OmniPage Pro can then use the 
character file in conjunction with its normal feature-analysis recognition to maximize 
recognition accuracy.

1. Place a sample page, which includes special characters, in your scanner.

2. Select Train Recognition in the Process Menu.

3. Adjust Train Settings (a subset of Scan Settings) and click OK.

4. After the scan, identify characters in the Train Recognition and Specify Character 
dialog boxes.

5. Save identified characters as a character file.

6. Select Scan in the Process Menu.

7. Adjust Scan Settings.
Set Page Options. 
Set Recognition Options: Character file.
Set Scanner Options.

8. Click OK.

Identify non-ANSI characters such as diamonds, clubs, and chess figures with a text string 
such as /club/.    When you open the file with software capable of creating those figures, you 
can use a search and replace feature to reinstate them.



Automatic Saving
With an automatic document feeder (ADF) and OmniPage Pro's automatic saving features, 
you can scan a batch of forms and have OmniPage Pro automatically save each form as a 
separate file with a unique file name.    Also, you can scan several sets of multi-page 
documents at once and have OmniPage Pro automatically save each set with a different file 
name.

If you are scanning a batch of pages you want to save as individual files, place the batch in 
your ADF.    If you are scanning several sets of pages and you want to create one file per set, 
put a blank white page between each set and then place the stack in your ADF.

1. Adjust Scan Settings.                              
Set Page Options: Multiple pages.
Set Recognition Options. 
Set Scanner Options.
Set Save Options: 
For a batch of individual forms, select Save text automatically and Multiple text 

files.For several sets of pages, also select Blank page between files.

2. In the Save Options dialog box, enter a path, format, and file name of one to five 
characters.    OmniPage Pro will increment the file name by appending 001, 002, 003, 
and so on as needed.

3. Click OK.

OmniPage Pro will scan and recognize the pages.    After recognition, the resulting text files 
will not appear in the Transitional Editor.

Use the same basic procedure (and select Image only) to scan and automatically save 
batches of images.    You can also scan a page for text recognition and simultaneously save 
the image as an image file by selecting Save image automatically and entering a file name.



Recognizing Image/Fax Files
OmniPage Pro recognizes text in image and fax files.    You may have a TIFF or PCX file 
created by a hand-held scanner not supported by OmniPage Pro.    You can recognize it if the 
file was scanned as black and white line art at 200 dpi or better.    OmniPage Pro also 
supports most popular fax file formats; you can recognize faxes directly from your hard disk. 
See the File Formats topic for a list of supported file formats.

1. Select Open in the File menu.

2. Click on Image/Fax in the Open dialog box.

3. Highlight the files you want recognized and click on Recognize.

4. Adjust Scan Settings.
Set Page Options.
Set Recognition Options.
Set Scanner Options.
Set Save Options.

OmniPage will scan and recognize the pages.    If you selected more than one file and did not
select Save text automatically, all the text will appear in one file in the Transitional Editor.

For best text recognition, TIFF files should be scanned at 300 dpi as line art.    Faxes should 
be transmitted in fine mode (200x200).    Faxes transmitted in normal mode (200x100) often 
do not provide adequate resolution for good text recognition.



Graphics
Use the Graphic Editor to scan or work with graphics.    The Graphic Editor is Caere's image-
editing software available when you select when you select Image... in the OmniPage Pro 
Process menu.    The Graphic Editor provides full control of your line -art or grayscale 
scanner.    You can enhance and touch-up line-art and grayscale images; print halftones that 
look like photos; and save your images in a variety of file formats wit several compression 
options.

Use the Graphic Editor Help for additional information on this topic.



Editing and Saving
The Transitional Editor lets you use OmniPage Pro's text editing and interactive spell 
checking features with the Verification Window: an important tool that displays the actual 
scanned image of any word by simply clicking on the word in the Transitional Editor.    In 
addition, the word's surrounding area is displayed so you can see the word in context.

Options in the Style menu let you format text in Bold, Underline and Italic styles. The 
Find/Replace option in the Edit menu provides several options for searching and replacing 
words and characters.

The interactive spelling checker suggests alternative words based on likely text-recognition 
errors rather than keyboard-entry mistakes.    Using this capability, the Auto Spell feature can
automatically spell-check and replace any mis-recognized words in an entire document.    

The US-version spelling dictionary contains 100,000 words.    To obtain foreign-language 
dictionaries, call Caere at (800) 535-SCAN. 

1. Scan and Recognize a document without selecting automatic save options.

2. In the Transitional Editor, use the Check Spelling, Find/Replace, and Style menu 
features.

4. Double-click on mis-recognized words to see the original images in the Verification 
Window.

5. Save the text file in an appropriate word-processor format by selecting File 
menu/Save as.

Save the file in Caere format (.met) if you are not sure what word-processor format in which 
you want to save a file, or if you may want to re-open the file in OmniPage Pro to use the 
spelling features.    Caere-format files are the only types of text files that can be opened in 
OmniPage Pro. 



Open...
Select Open... to edit a Caere-format (.met) text file, recognize text in existing image or fax 
files, or start recognition on a deferred job.



Opening a Text File
You can open a text file that was previously saved in Caere format (.met). A Caere-format 
text file is the initial text file created by OmniPage Pro after a text-recognition process. By 
initially saving a text file in Caere format, you can reopen the file and then save it in any 
number of other supported file formats you wish.

To open a text file from the Open dialog box:

1. Click on the Text button in the center of the dialog box.
2. Specify the path and directory where your Caere-format files reside.
 Files in the specified directory will appear in the Files list box.
3. Click on the appropriate file name.
 The file name will appear in the Selected files list box. If you change your mind and 

want to remove a file name from the box, highlight it and click on Clear. To remove all
the file names from the list, click on Clear All.

4. Click on Open.

The file will appear in the Transitional Editor. You can then edit the file and save it in any of 
the supported output file formats.



Opening Image/Fax Files
OmniPage Pro can recognize text in one or more image or fax files at a time. For example, 
you may have a number of TIFF files stored on the network or you may have a day's worth of
faxes in a directory on your hard disk.

See Appendix A of the Owner's Manual for a list of supported image and fax file formats.

 To recognize text in one or more image or fax files:

1. Click on the Image/Fax button in the Open dialog box.
2. Specify the path and directory where your image or fax files reside.
 Files in the specified directory will appear in the Files list box.
3. Select the files you want recognized by clicking on them.
    To select all the files in the list, click on Select All.
 Selected files will appear in the Selected files list box on the right. If you change your 

mind and want to remove a file name from the box, highlight it and click on Clear. To 
remove all the file names from the list, click on Clear All.

4. When all the files you want recognized appear in the Selected files list box, click on 
Recognize.    The Recognize Settings dialog box will appear.

5. Adjust Recognize Settings as needed and click on OK.
If you recognize more than one file at a time, all the files will combine into one text 
file. If you want the text from each image or fax file saved as a separate file, select 
Save text automatically and Multiple text files in the Save Options of the Scan dialog 
box.



Opening a Deferred Job
A Deferred job is a file created when you select Defer recognition in the Recognition Options 
of the Scan Settings dialog box and you choose to save the job for later recognition.

For a complete description of this feature, see the Defer recognition topic.

To open a Deferred job:

1. Click on the Deferred job button in the Open dialog box.
2. Follows steps 2-4 in Opening Image/Fax Files above.
 The Deferred job(s) will be immediately recognized according to the Scan Settings in 

effect when the job file was created. The Recognize Settings dialog box will not 
appear.



Save 
Select Save to write the contents of your current working file to disk.

Your file will be saved to disk and you can continue working on your file. If you are saving the
file for the first time, the "Save As..." dialog box will appear.



Save As
Select Save As to choose a file format and save a file to disk.
 
The Save As... dialog box displays the current path and directory, a file name box, and a list 
of file formats. After entering a path and file name, click on the appropriate file format in the 
Format selection box; OmniPage Pro will automatically add the appropriate file format 
extension to the file name. After saving, the current working file returns to the screen.

See the File Formats help topic for a list of supported word-processor, database, fax, and 
image file formats.

There are two ways to save a text file in more than one file format:

Save the file in Caere (.met) format. A Caere-format file is the initial text file created 
by OmniPage Pro after a text-recognition process. By first saving the file in Caere 
format, you can later open the file in OmniPage Pro and save it in different file 
formats.

While the initial text file is open in the Transitional Editor, save it in each format you 
want. Remember, only a Caere-format file can be re-opened (and re-saved in a 
different format) in OmniPage Pro.



Close
Select Close to stop working on a file.

A prompt will appear and ask you if you want to save the current file if it has changed since 
the last save. The main OmniPage Pro screen will then appear.



Revert to Saved
Select Revert to Saved to lose edits made to a file and return to the last-saved version of the
file. For example, if you have cut-and-pasted text into unreadable gibberish, select Revert to 
Saved and the file will reappear as it was before you last saved it.



Print
Select Print to print a document from the Transitional Editor.

OmniPage Pro will print the document according to the current Windows print settings. To 
change printers or print settings, open Printers in the Windows' Control Panel program. Refer
to your Windows User's Guide for detailed instructions.



Exit
Select Exit to quit the OmniPage Pro program.

A prompt will appear and ask you if you want to save your current working file.



Verification Window
The Verification Window is an important feature that lets you check the context of text you 
want to edit. If you double-click on a word in the Transitional Editor, the scanned image of 
the word and its surrounding area will appear. You can see the original image of the 
document and edit the text file accordingly.

The Verification Window displays the original scanned image of a document; it will not show 
the original image of text that has been cut or pasted in the Transitional Editor.

Text recognition is faster when the Verification Window is turned off. To turn off the window, 
select System in the Defaults menu. In the System Defaults dialog box, de-select Verification
Window.



Cut
Select Cut to delete selected text from the screen.

To select text, position the text cursor at the start of the text you wish to select. Hold the 
mouse button down and drag the cursor across the text; the selected text will appear 
highlighted.

Cut text is stored in the clipboard and may be pasted anywhere in the document (see the 
Paste command). The text remains in the clipboard until new text is cut or copied.



Copy
Select Copy to duplicate selected text.

For instructions on how to select text, see the Cut command topic. Once text is selected, 
click on Copy. Then move the cursor to where you want to place the copied text and click on 
Paste.

Copied text is stored in the clipboard and may be pasted anywhere in the document. The 
text remains in the clipboard until new text is cut or copied.



Paste
Select Paste to place cut or copied text on the screen. Pasted text will appear at the text 
cursor location. A copy of the pasted text remains in the clipboard until new text is cut or 
copied.



Clear
Select Clear to permanently delete selected (highlighted) material from the screen.

For instructions on how to select text, see the Cut command topic.



Find/Replace
Select Find/Replace to show or remove the Find/Replace toolbar in the Transitional Editor. 
When toggled on, the toolbar appears below the menubar.

To find a word or set of characters, type the word or set of characters in the Find: edit box. 
Then click on the Find button. The Verification Window will display the image of the word. To 
repeat the search, click on Find again.

To replace a word or set of characters with another word, type the word you want to replace 
in the Find: edit box. Type the replacement work in the Replace: edit box and then click on 
the Replace button. To replace all instances of a word, click on the Replace all button.

The Options selection box provides different ways to find and replace words:

Additional topics

Match case
Whole word
Find Backwards
Wrap around
Find After Replace



Additional Topics for Find/Replace
Match Case

To be found, a word must exactly match the upper- and lower-case attributes of the word in 
the Find: edit box.

Whole Word

To be found, a word must match, in length, the work in the Find: edit box. Compound words 
that contain the searched for word within them will not be found.

Find Backwards

The search will progress backwards from the location of the text cursor to the beginning of 
the document.

Wrap around

After reaching the end of a document, the search will continue from the beginning of the 
document to the location of the text cursor.

Find After Replace

After a found word is replaced, the next instance of the work in the Find: edit box will be 
searched.



Check Spelling
To check a text file for spelling errors, click on the Check button. All text following the cursor 
will be checked. If an area of text is highlighted, OmniPage Pro will only check the 
highlighted text.

When OmniPage Pro finds a misspelled word, the misspelled word is highlighted in the text 
file and the OK and Add buttons become active. The Verification Window displays the image 
of the word and a list of suggested replacement words appears in the Suggestions:list box. 
Select Spelling in the Defaults menu for spelling and dictionary options.

Additional topics

Check
OK
Add
Suggestions



Additional topics for Spelling
Check

Clicking on Check starts or continues the spell-checking process. If a misspelled word is 
highlighted and you click on Check, OmniPage Pro will ignore the word and find the next 
misspelled word.

OK

Clicking on OK adds the misspelled (or highlighted) word to a temporary dictionary. 
OmniPage Pro will ignore future instances of the word and will go on to find the next 
misspelled word.

The temporary dictionary is active until you close the document or change dictionaries.

Add

Clicking Add adds the misspelled (or highlighted) word to your permanent User Dictionary. 
OmniPage Pro will ignore future instances of the word and will go on to find the next 
misspelled word.

Suggestions

Clicking on a word in the Suggestions:edit box replaces the highlighted word in the text with 
the word in the edit box. The misspelled word is kept in the Suggestions:edit box in case you
want to click on it and return it to the text.

Click on Check to continue to the next misspelled word.



Auto Spell
Auto Spell automatically checks spelling errors and replaces unknown words with words that 
are most likely to be correct. OmniPage Pro determines replacement words by computing 
likely text-recognition errors. To use Auto Spell, first choose an insertion point in your 
document. OmniPage Pro will check all text following the cursor. Then select Auto Spell. A 
dialog box will appear.

When the Ignore abbreviations etc. box is checked, abbreviations, acronyms, and proper 
names will not be altered. See Select Dictionary for an explanation of spelling options 
invoked by the Ignore Abbreviations, etc. box. To start Auto Spell, click on the Begin button.

As Auto Spell checks a document, the dialog box displays the current page it is checking, the
number of words it has replaced, and the total number of words it has checked. If you find 
that Auto Spell replaced a significant number of words, you may want to click Cancel and 
replace the misspelled words interactively with the Check Spelling feature.

Auto Spell invisibly marks each word it replaces. To check the replacement words, you can 
run the Check Spelling feature. This feature will stop on each word Auto Spell replaced and 
allow you to check the word within the context of the document.



Spelling Defaults
Use Spelling defaults to select main or user (personal) dictionaries for the spelling features. 
The Spelling defaults dialog box will appear.

The left selection box shows the main dictionaries installed on your system. These 
dictionaries have the file name extension .md. The right selection box lists user (personal) 
dictionaries. These dictionaries have the file name extension .ud. One main (US or foreign 
language) and one user dictionary may be active at the same time. 

Foreign-language dictionaries are available from your local Caere distributor or by calling 
Caere at (800) 535-SCAN.

To learn how to add words to the current dictionary, see the User Dictionary topic.

Additional topics

Ignore all CAPS
Ignore proper nouns
Ignore abbreviations
Phonetic suggestions
AutoSpell after recognition



Additional topics for Spelling Defaults
Ignore all CAPS

OmniPage Pro will ignore entirely capitalized words of four characters or less (for example, 
HUD, USDA, etc.)

Ignore proper nouns

OmniPage Pro will ignore a word not beginning a sentence that has a capitalized first letter 
(for example, He saw Jane throw...)

Ignore abbreviations

OmniPage Pro will ignore a capitalized letter followed by three or fewer lower case letters 
and a period (for example, Mrs., Cal., etc.)

Phonetic suggestions

The Suggestions:edit box in the Check Spelling toolbar will list suggested replacement words
based on phonetic possibilities as well as likely OCR errors. For example, if OmniPage Pro 
encounters the word "coarn," it may suggest "Koran," or "corner," as well as "corn."



User Dictionary
Select User Dictionary to edit entries in your personal dictionary. You can build a custom 
word list that includes special words used in your profession.

The box on the left lists all the words currently in the user dictionary. The edit box on the 
right lets you add a word to the list. To make a word appear in the edit box, you can either 
type the word or highlight the word in the list box. You will then have the following options:

Add

Click Add to add the word in the edit box to your user dictionary.

Delete

Click Delete to delete the word in the edit box or a word highlighted in the list box from your 
user dictionary. Delete several words by highlighting them in the list box (use the Shift key - 
click combination) and clicking on Delete.

You can add all the words from a particular document to your personal dictionary or save 
your word list as a text file by using the Import and Export features.

Import

Import lets you add words in a text file to your user dictionary. For example, you may want 
to add technical terms from a particular document. When you select Import, a dialog box will
appear prompting you for a file name. Enter the file name of the document that contains 
words you would like to have in your user dictionary. The program will go through the text 
file, discard words that are already in the main or user dictionaries, and add the words that 
are left to your user dictionary.

The imported text file can be any document or word list that is in ASCII format. Most word 
processors have a way of converting a file into ASCII format; see your program's 
documentation.

Export

Export lets you save your user dictionary as a text file. When you select Export, a dialog box 
will appear prompting you for a file name and destination. You will be able to use the text file
in other dictionaries or save it for later use with OmniPage Pro.

Purge

Purge deletes all words from your user dictionary.

Save As

Save As lets you name and save a new dictionary or save an edited dictionary with a new 
name.

OK

OK saves your editing dictionary and exits the User Dictionary option.



Cancel

Cancel exits the User Dictionary function without saving any changes.



Scan
Select Scan to adjust scan settings and scan a document. The Scan Settings dialog box will 
appear:

Scan settings appearing in the dialog box are the last settings used. The dialog box is 
divided into four sections:

Page Options describe the physical characteristics of the page you are scanning: its size, 
orientation, and so on.

Recognition Options describe how you want OmniPage Pro to recognize the page: whether
it will look for multiple columns, whether you want specific portions of the page recognized, 
and how you want the text to be formatted for your application. 

Scanner Options control how your scanner will scan a page: the resolution and brightness.

Save Options describe how you want to save your output: automatically, corresponding to 
double-sided pages, and so on. Clicking on the Save Options button opens the Save Options 
dialog box.



Page Options
Page Options describe a page's physical characteristics.

The options are:

Size
Orientation
Doc type
Multiple pages



Size
The Size list box lets you select the dimensions of the document you are scanning. Select:

Letter for 8.5" by 11" size pages.
A4 for 21cm by 29.7cm European-size pages.
Legal for 8.5" by 14" size pages.



Orientation
The Orientation list box lets you select the orientation of the document you are scanning. 
Select:

Portrait if your page is printed in portrait orientation as shown below.
Landscape if your page is printed in landscape orientation as shown below.

When scanning landscape-oriented pages, be sure you load them in your scanner correctly. 
See the Scanners booklet for instructions on how to load your scanner.



Doc type
The Doc type list box lets you select various font characteristics of your document.

Fully formed

Select Fully formed for conventionally printed text characters.

Dot matrix

Select Dot matrix for characters printed in draft mode by a 9-pin dot-matrix printer. Do not 
select Dot matrix for pages printed in near-letter-quality mode or printed by a 24-pin dot-
matrix printer.

When you are finished scanning with the Dot matrix setting, be sure to toggle the setting off.
The Dot matrix setting is only appropriate for draft-mode, 9-pin dot-matrix printed material.

OCR-A

Select OCR-A if all of the characters in your document are printed in OCR-A font. If the 
document contains a mixture of OCR-A and a conventional font, select Fully formed for faster
recognition.



Multiple pages
Select the Multiple pages checkbox if you want to scan multiple pages into one text file.

After a page is scanned and recognized on a flatbed scanner, a prompt will appear asking 
you if you want to scan more. If you use an automatic document feeder (ADF), the prompt 
will appear when the ADF is empty.

The Transitional Editor displays text one page at a time: if you select Multiple pages and 
scan three pages, only the first page shows when the text file appears in the Transitional 
Editor. To see or edit different pages, use the slide control in the bottom left corner of the 
screen: left to go to a lower page number, right to go to a higher number. The page icon in 
the slide shows which page is currently displayed. If you want to scan multiple pages and 
create a different file for each page, select Multiple text files in Save Options.



Recognition Options
Recognition Options describe how you want OmniPage Pro to recognize your document.

The options are:

Column selection mode
Character file
Multiple zones
Defer recognition
Manual block selection
Interactive mode
Retain format



Column selection mode
Column selection modes describe how blocks of text on the page will be ordered for 
recognition. For text recognition, OmniPage Pro usually divides a page into a series of text 
blocks and strips out graphics. If text blocks are separated by white space (gutters), 
OmniPage Pro recognizes separate columns of text blocks and orders text in the text file 
accordingly. Depending on the Column selection mode, OmniPage Pro either automatically 
discerns columns of text blocks, recognizes a designated number of columns, or recognizes 
the page as a single column of text blocks.

Auto detect

Select Auto detect if you want OmniPage Pro to automatically discern columns.

With the Auto detect setting, OmniPage Pro looks for regular vertical separations of text 
(gutters) to define columns. It then recognizes column-wide text blocks. It starts at the top of
the first column, moves to the bottom, and then continues to the top of the next column, 
"snaking" through the text. The resulting text file displays the text in one column from 
beginning to end.

Single column/Tables

Select Single column/Tables when there is one column on a page as with correspondence or 
when scanning a table, financial form, or spreadsheet.
 With the Single column/Tables setting, OmniPage Pro treats the entire page as one column. 
It starts at the top of the page and moves to the bottom outlining page-wide text blocks. If 
OmniPage Pro detects five rows or more of characters divided into columns, it assumes the 
document is a spreadsheet. It will insert tabs as delimiters between the columns and 
preserve the tabular format.

Do not use the Auto detect setting for tables and financial forms. Although these kinds of 
documents have multiple columns, snaking will destroy their spreadsheet format.

No parsing

Select No parsing to have OmniPage Pro recognize the entire document as a single text 
block.

OmniPage Pro will not divide the text into separate text blocks or strip out graphics. The 
document will be recognized as one text block; if there are graphics on the page, OmniPage 
Pro will attempt to recognize them as text elements.

 This feature is useful if you are scanning small text that might appear as graphics to 
OmniPage Pro: for example, telephone book pages. Also, use No parsing if you are scanning 
multiple small zones.

Multiple columns (n)

Select Multiple columns (n) if you want to designate the number of columns on a page. The 
number in parentheses is the number of columns; you can select up to nine columns.

In the example on the left, there are two main text columns. A table is at the bottom of one 
column. Normally, you would use Auto detect to recognize the two columns; however, to 
recognize the table, you would need the Single column/Tables setting. The solution is to use 



Multiple columns (2), designating two columns. OmniPage Pro will then accurately recognize 
the table as well.

This option is not available (or necessary) when you use a Hewlett-Packard scanner with HP 
AccuPage.



Character file
You can select a file of trained (pre-recognized) characters to augment the recognition 
process.

All existing character files are listed in the selection box; simply highlight the appropriate file
and continue to set other options. For a complete description of how to create a character 
file, see the Custom Character Recognition help topic.



Multiple zones
Select Multiple zones when you want specific sections, or areas, of a page recognized. If the 
Multiple zones option is off, the entire page will be recognized.

For a complete description of how to use the Multiple zones feature, read the Multiple Zones 
and Zone Contents help topic.



Defer recognition
Select Defer recognition to scan pages and delay text recognition.

After you set other options and click OK, OmniPage Pro will scan your page or pages. You will
be able to select zones (if you selected Multiple zones) or blocks (if you selected Manual 
block selection). You will then be prompted to either recognize text or to save the page, 
selected zones, or blocks as a deferred job for later recognition. The saved file (with the 
extension .job) can later be recognized by highlighting the file in the File menu Open... 
dialog box and clicking the Recognize button.

This feature is most useful when you want to select different zones or text blocks on multiple
pages. Instead of selecting areas on a page, recognizing the text, selecting areas on the next
page, recognizing the text, and so on, you can select areas on one page, select areas on the 
next page, and so on, and then recognize the selected areas all at once.



Manual block selection
Select Manual block selection to pick specific text blocks you want recognized and arrange 
them in a particular order.

This feature is useful when a page is composed of irregular columns or text articles 
interrupted by captions, sidebars, etc. For example, a magazine page may have three 
columns in one area and a wide, single column in a text box. In order to correctly set the 
order in which the text blocks will be recognized, you pick the blocks you want recognized 
and, if necessary, reorder them.

Text blocks are numbered, indicating the order in which they will be recognized.

To pick blocks for recognition, click on the selection tool (the pointer) in the toolbox and click
on the blocks you want recognized. They will become highlighted.

To re-order blocks for recognition, click on the ordering tool (the # symbol). The numbers in 
the text blocks will disappear. Click on the first block you want recognized, then the second 
block, and so on. The blocks you click on will appear numbered and highlighted.

You can zoom your view of the blocks in or out by clicking on the zoom tools (the magnifying
glasses). Zoom levels are Fit in Window, 25%, 50%, and 100%. To zoom all the way in or out,
hold down the CTRL key when you click on a block.

When you are done selecting and ordering blocks, click on OK in the toolbox to start 
recognition.



Interactive mode
Select Interactive mode if you are scanning multiple pages into one text file and you may 
want to change settings for different pages. The Scan Settings dialog box will reappear after 
each page is scanned.

For example, imagine you are scanning a magazine article that stretches over several pages.
You select Multiple zones because you don't want to recognize all the advertisements that 
are on the page. You also select Interactive mode because each page has a different text/ad 
layout and you will have to select different zones for each page. After each page is scanned, 
the Scan Settings dialog box appears where you can set options for the next page.

If you would prefer that the Scan Settings dialog box not reappear with each page and that 
you just have the option of drawing new zones, select Interactive mode - set Scan Settings 
in the System Options dialog box. This dialog box is available by selecting System in the 
Defaults menu.

Save Options are not available during an interactive mode scanning sequence.



Retain format
Select Retain format if you want OmniPage Pro to retain the original format of the document 
in the created text file.

If Retain format is selected, OmniPage Pro will re-create the following formatting features 
when it creates a text file of the recognized document: indentation (regular, hanging, or 
none), justification (left, right, or ragged right), blank vertical space (six lines per inch), and 
centered lines.

If the file is saved in a non-ASCII format, features such as boldface, italics, and underlining 
will also be saved. Files saved in ASCII format do not retain any formatting other than spaces
and carriage returns.

This feature is useful for handling forms such as resumés.

The Multiple zones feature is unavailable if Retain format is selected.



Scanner Options
Scanner Options set parameters for your scanner.

The options are:

Resolution
Auto intensity
Brightness



Resolution
Select the resolution for your scan.

Scanning at 400 dpi (if your scanner supports it) provides sharper image resolution. Text-
recognition accuracy improves with 400 dpi. However, the recognition speed is much slower 
than at 300 dpi, and system memory requirements are higher. OmniPage Pro will pause for a
few seconds if you select or de-select 400 dpi.

The recommended resolution for text recognition is 300 dpi. For image scans, you may wish 
to use a lower resolution to save disk space. However, the quality of the image will be 
diminished.

OmniPage Pro does not support scanning a legal size page at 400 dpi.



Brightness
Select different brightness settings to lighten or darken a scanned image.

This setting is needed to account for variations in paper quality, print quality, and scanner 
peculiarities. It acts like the brightness setting on a copier.

The Brightness setting is the most important means you have to affect the accuracy of text 
recognition.

Set Brightness by moving the mouse arrow to the square in the slide, holding the mouse 
button down, and moving the square toward the desired setting. Or, click on the arrows to 
the left or right of the slide. Use the numbers in the square as references for future 
documents. The caret represents the scanner's "normal" setting.

If a page has sharp, distinct characters printed on good-quality non-reflective paper, set the 
Brightness slide to the middle, normal (marked by a caret) setting.

If a page has thin, broken characters or if it is printed on glossy paper, darken the Brightness
setting by moving the slide toward the right.

If a page has thick, run-together characters or if it is printed on porous paper such as 
newsprint, lighten the Brightness setting by moving the slide toward the left.

To evaluate Brightness settings, watch the Character Window as OmniPage Pro performs text
recognition. See the Character Window help topic.



Auto intensity
Select this option if OmniPage Pro can automatically set an optimal brightness setting with 
your grayscale scanner.

This feature is especially useful when you scan text printed on colored paper. If you scan 
high-quality documents with crisp, black letters printed on white paper, recognition may be 
faster with this option turned off.



Save Options
Save Options describe how you want to save files.

You can save files two ways:

Automatically, by using the Save text automatically or Save image automatically options in 
the Save Options dialog box.

Manually, by using Save As... in the File menu from the Transitional Editor after the file is 
processed.

Options let you set different save procedures. If you select Save text automatically or Save 
image automatically, you must set save parameters in the Text/Image Save Options sections
of the dialog box.

The options are

Save text automatically
Multiple text files
Blank page between files
Double sided
Save image automatically

The Save Options also let you specify your file name, directory and file format.



Save text automatically
Select this option if you want OmniPage Pro to automatically save a text file after 
recognition. The file will be saved according to the parameters you specify in the Text Save 
Options. If you also select the Multiple text files option, OmniPage Pro will automatically 
increment your file name for each page.



Multiple text files
 If you selected Multiple pages in Page Options and Save text automatically, select this 
option if you want OmniPage Pro to automatically increment file names and create a 
separate text file for each page that is recognized.

OmniPage Pro will automatically increment your file name for each page scanned. Your file 
name must be five characters or fewer. OmniPage Pro will add the characters 001, 002, 003 
(and so on) to your file name.

For example, if you select a file name form the first file will be named form001, the second 
file will be named form002, and so on. An extension to the file name will be added 
depending on your choice of file formats. In the event of a duplicate file name, OmniPage Pro
will automatically overwrite the old file.



Blank page between files
If you selected Multiple pages in Page Options and Save text automatically and Multiple text 
files and you use an automatic document feeder, select this option if you want OmniPage Pro
to begin a new file when it scans a blank page.

For example: You have three sets of pages that you want recognized into three separate 
files. You put the first set of pages in the feeder, insert a blank page, put the second set of 
pages in the feeder, insert a blank page, and then put the last set of pages in the feeder. You
select Multiple pages, Save text automatically, Blank page between files, and you enter the 
file name FORM in the Text Save Options. OmniPage Pro will scan and recognize the first set 
of pages and the first blank page, save the text file as FORM001, process through the 
second set of pages and the second blank page, increment the file name and save the file as
FORM002, and then process and save the third set of pages as FORM003.



Double sided
If you selected Multiple pages in Page Options and are using an automatic document feeder 
(ADF), select Double sided if you scan pages that are printed on both sides: page 1 is on one
side, page 2 is on the other side (and so on). OmniPage Pro will scan a stack of pages and 
then prompt you to turn the entire stack over to scan the reverse sides.

For example, imagine you have three double-sided pages numbered 1 through 6 (1 is on the 
front, 2 is on the back, 3 is on the front, 4 is on the back, and so on). OmniPage Pro will first 
scan pages 1, 3, and 5 and then prompt you to turn the stack over in the ADF. It will then 
scan pages 6, 4, and 2. The resulting text file will consist of pages 1, 2, 3, 4, 5, and 6 in the 
correct order.

If you were scanning several stacks of pages into one text file, OmniPage Pro would then 
scan pages 7, 9, and 11 (and so on), and then ask you to turn the stack over. It would then 
scan pages 12, 10, and 8 (and so on) and append them to the first stack.



Save image automatically
Select this option if you want OmniPage Pro to automatically save an image file. The file will 
be saved according to the parameters you specify in the Image Save Options.



File name
Type the desired path and file name in this box. Then click on the desired file format in the 
Format selection box. An extension matching the file format you choose will automatically be
appended to the file name when the file is saved.

If you select the Multiple text files or Multiple image files option, file names are limited to 
five characters.



Directory
This shows the current path and directory as indicated in the File name edit box.



Format
Scroll through this selection box and highlight the file format in which you want the file 
saved. Most popular word-processor, database, compressed TIFF, uncompressed TIFF, and 
PCX file formats are available; for a complete list, see the File Format topic.



Quick Scan
Select Quick Scan if you want to scan and recognize a document using all current Scan 
Settings. The Scan Settings dialog box will not appear.



Image
Select Image to scan, edit, or print a graphic image. The Graphic Editor image editing 
program will launch.

Within the Graphic Editor, you can scan and edit both line-art and grayscale images. You can
print images using Caere's LaserGray printing technology directly from the Graphic Editor.

For additional help on this topic, refer to The Graphic Editor Help file.



Train Recognition
Select Train recognition to create a character file to augment text recognition.

A character file is a set of pre-identified text characters. When you select a Character file in 
Recognition Options in the Scan/Recognize Settings dialog box, OmniPage Pro will compare, 
during recognition, unrecognized characters with the set of pre-identified characters in the 
character file.

For a complete description of how to use the Train Recognition feature, read the Custom 
Character Recognition help topic.



Edit Character File
Select Edit Character File to view or edit an existing character file.

When you select Edit Character File, an open dialog box will appear. Select the character file 
you want to view or edit and click OK. The Train Recognition dialog box will appear. You can 
then use this feature just as it is described in the Custom Character Recognition help topic.



Edit Zone Contents File
Select Edit Zone Contents File to create or edit a file of characters for use with the Zone 
contents feature of the Multiple zones toolbox.

For a complete description of how to use the Edit Zone Contents File feature, read the 
Multiple Zones and Zone Contents help topic.



System
Select System to customize OmniPage Pro operations to suit your personal preferences.

The System Options dialog box will appear.

Verification Window

If checked, the Verification Window will be available in the Transitional Editor to help you edit
text. However, the Verification Editor slows text recognition; if you prefer speed, de-select 
this feature.

Multiple zones - clear after each scan

If checked, drawn zones will be cleared after each scan when Multiple zones is selected. If 
you are scanning forms and you want the same area of the page recognized on each page, 
de-select this option. Any zones you draw (or change) will reappear the next time you use 
Multiple zones.

Interactive mode - set Scan Settings

If checked, the Scan Settings dialog box will appear before each page is scanned when 
Interactive mode is selected. If you want just the Multiple zones toolbox to appear between 
scans, de-select this option.

Confirm on file close

If checked, a warning box will appear whenever you exit OmniPage Pro or close a file without
saving. A prompt will ask if you want to save the current file. To turn the warning box off, 
deselect this option.

Enable upside-down recognition

If checked, OmniPage Pro will automatically reorient a scanned image if recognition is 
extraordinarily poor/ The program assumes that you accidentally loaded a page upside-down
in the scanner.

You may choose to turn this option off to scan a difficult-to-recognize document in order to 
create a character file or to scan dot-matrix printed documents.

Reject character

This edit box lets you choose a character to mark unrecognized characters in your text file. 
For example, if OmniPage Pro could not recognize the J in REJECT, and the tilde (~) was the 
reject character, the string RE~ECT would appear in your text file.



Languages
Select Languages to choose one or more languages for text recognition.

OmniPage Pro will recognize additional characters (such as circumflexes, umlauts, etc.) 
unique to a particular language. You may select more than one language by clicking on 
multiple selections; however, for faster recognition, use only the minimum number you 
need.



Scanner
Select Scanner to set up a different scanner.

To change a scanner, read the Changing Your Installation topic. Also, read the Scanners 
topic.

After installing a different scanner, open OmniPage Pro and select Scanner. The Select 
Scanner dialog box will appear.

Highlight the appropriate scanner name and click OK. If a particular scanner requires 
parameters such as port addresses, speeds, or interrupt vectors, a dialog box will appear 
where you can enter values. See the Scanners topic for information about scanner 
parameters.



Default Dictionary
Use Default Dictionary to set default main or user (personal) dictionaries and options for the 
spelling features.

The Default Dictionary dialog box will appear.

The upper selection box shows the main dictionaries installed on your system. These 
dictionaries have the file name extension .md. The lower selection box lists user (personal) 
dictionaries. These dictionaries have the file name extension .ud. To select a dictionary for 
the spelling features, highlight the appropriate dictionary listing and click on OK. One main 
and one user dictionary may be active at the same time.

You may also set spelling options. For a description of these settings, see the Select 
Dictionary topic.

Select Auto spell after recognition to have OmniPage Pro automatically use the Auto Spell 
spell-checking feature immediately after an image is recognized.

Foreign-language dictionaries are available from your local Caere distributor or by calling 
Caere at (800) 535-SCAN.



Load
Select Load to open a previously saved set of Scan Settings.

For example, you may have three distinct kinds of documents that you often scan: one with 
Landscape orientation, one requiring Multiple zones, and one requiring a darkened 
Brightness setting. By using Default settings, you can simply load a settings file and then 
scan documents with the appropriate settings.

After you select Load in the menu bar, an Open dialog box will appear. This box displays a 
list of Default Settings files. To load a file of settings, highlight a file name and click on Load 
in the dialog box. The Scan Settings dialog box will appear with the file's settings selected.

To load a file of settings and immediately scan or recognize a document, highlight a file 
name and select Scan. The Scan Settings dialog box will not appear.

The settings will remain current until they are changed or until a new Default Settings file is 
loaded.



Save
Select Save to save the current Scan settings as a Default Settings file.

A Save dialog box will appear. To save a file, type a file name and click OK. The current 
settings will be saved as a Default Settings file.



The Help Menu
The Help menu lets you get information about OmniPage Pro and its performance.

With this menu you can:

See the Help Index of commands, settings, and procedures for OmniPage Pro Help.

Display Statistics showing recognition performance.

Learn About OmniPage Pro versions, copyrights, and serial number.



Display Statistics
The Display Statistics box shows how well OmniPage Pro recognized the last-recognized 
document: the percentage of unrecognized characters, recognition time, and so on.

Display statistics are valuable for comparing the effect of different settings on recognition 
accuracy. For example, if you are not sure about a proper brightness setting, you can 
compare the recognition accuracy percentages with different settings. You can also quickly 
tell if a poor-quality document is worth scanning; if the recognition accuracy is less than 
96%, it might be quicker to get another copy of the document or to enter the text manually.

Total characters indicates the number of characters and spaces in the file.

Recognition time indicates the time it took for parsing (breaking the page down into text and
graphics) and recognition. It does not count scanning time, the time it takes to select 
multiple zones, or the time spent writing data to disk.

Known errors indicates the number of unrecognized characters. It does not count improper 
substitutions or incorrectly recognized formatting commands.

Recognition rate in characters per second (cps) is the total number of characters divided by 
the recognition time. In words per minute (wpm), it is assumed the average word is five 
characters long. The formula for wpm is [characters per second divided by five] times sixty.

Accuracy rate is determined by the formula [Total characters minus Known errors] divided by
Total characters.



About OmniPage Pro
The About OmniPage Pro box shows the current version you are using, any copyrights in 
effect, the program's registered user, company name, and serial number.



Style Menu
The Style menu lets you format character styles while you edit a text file in the Transitional 
Editor. With this menu, you can format text in Bold, Underline, and Italic styles.

To change character formatting, position the text cursor at the start of the text you wish to 
format. Hold the mouse button down and drag the cursor across the text; the selected text 
will appear highlighted. Select any or all formatting options in the Style menu.

Bold Select Bold to change highlighted characters to boldface format.

Italic Select Italic to change highlighted characters to italicized format.

Underline Select Underline to change highlighted characters to an underlined format.

Normal removes all formatting options from your text.

Note: All character formatting is lost if you save a file in ASCII or ANSI format.


